








Section 3 Operation

3.1 User interface

Main window
Double-click the FLO-WARE icon on the desktop to open the main window (Figure 1).

Figure 1 Main window

Themes panel—measurement channels Balloon help—descriptions of icons and links

Options panel—language options and device drivers Program style—color and style options for Flo-Ware

View panel—main view and data views Main view—changes with the selected menu
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Main toolbar—icons shown in all windows Main-view tasks—links for basic tasks and information

3.2 Raw data

The Raw Data view shows the data or project file in a spreadsheet. The columns correspond
to the themes that are shown in the Themes panel. The maximum number of records is
limited only by the computer memory.

Navigation in the Raw Data view is similar to navigation in common spreadsheet software.
Use the arrow keys on the computer keyboard to move up, down, left or right. Use hot keys
such as Ctrl + End to move the cursor to the last cell in the spreadsheet. Use Ctrl +
Home to move the cursor to the first cell in the spreadsheet.
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3.2.1 Edit data

Data can be adjusted in the raw data view to change incorrect values. For example, if a
value for the level measurement indicates 0 volume, the corresponding velocity value should
also be 0. If the velocity value is not 0, a velocity value of O can be entered.

1. Click to select a data cell in the raw data view.
2. Use a method to change the values:

Option Description

Manual Use the computer keyboard to change the value. Any calculated values, such
as flow, are automatically recalculated. For example, if the velocity value is
doubled, the flow is automatically recalculated.

Find/Replace Use the FIND/REPLACE button to search for data and replace the value.

Calculator Select one or more data cells and and select add, subtract, multiply or divide
from the Operator field on the toolbar. Enter a value and click the
RECALCULATE SPREADSHEET button.

Note: To highlight multiple cells, click in a data cell and drag down. Alternatively,
click in a data cell, press the shift key and click in another cell.

3.2.2 Export data

Data can be saved in a .txt or .csv file format for use in common applications such as
Microsoft® Excel® spreadsheet software.

1. Open a data or project file in the Raw Data view.

2. Click the EXPORT button from the toolbar of the Raw Data view. The Export window
opens.
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To change the date and time range, click on the start time or end time that is shown.
The Date/Time window opens. Select a new date and time range and click OK.

Select a Data Interval. The intervals in the exported data file can be different from the
intervals in the raw data file. For example, the raw data file can have 15 minute intervals
and the exported data can have hourly or daily intervals.

Click EXPORT. The Save Export File As window opens.
Enter a file name and location.

Select either the tabbed text (.txt) or comma separated values (.csv) file format and click
SAVE.

3.2.3 Open data or project files

A datafile is created whenever data is transferred from an instrument to the computer. Open
these files to view and analyze the data. When data files are opened in Flo-Ware, a project
file is automatically created.

The project file contains the charts, text reports, themes and analysis for the data. Save the
project to retain the changes that were made. When the project file is opened at a later date,
the project opens up at the point where it was last saved.

1.

Click on the FILE OPEN button on the main toolbar. The Open File window opens
(Figure 2).

In the Type section, select a file type:

*  Flo-Ware Project Files—previously-opened files that were saved as a project.
* Instrument Files—available for an instrument if the file driver for that instrument was
installed.

In the Look In section, click BROWSE to select the folder where the data files are
located. Once a path is selected, it will be available from the drop-down list.

In the File Name section, click to highlight the data file to open. To highlight more than
one file, press and hold the shift key and then click additional files.

If a project is currently open, the Import Options section is shown. Select whether to
start a new project or import the data into the current project.
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Figure 2 Open file window
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6. Click OK. The Data Interval window opens.
7. Select the time span and data interval.

Option Description

Start Time  The start time of the data file is shown initially. A different date and time can be
selected.

End Time The end time of the data file is shown initially. A different date and time can be
selected.

Data Interval The data interval that is set for the instrument is shown initially. A different interval
can be selected and the data will be averaged.
Note: Some intervals are not compatible with the intervals set for the instrument.
For example, if the instrument is set to record in 3- or 15-minute intervals, the 1-
and 5-minute intervals in Flo-Ware are not available.

Click OK. The file, if a single file and a new project, opens in the Raw data view.

If the file is imported into the current project, or if multiple files are opened, the Theme
Data window opens. Select Import (side by side) or Append (string the data together)
and click OK.

Option Description

Import Data A side-by-side presentation is useful when the data from many different sites is
plotted in one project. This presentation is useful, for example, when comparing
upstream and downstream sites within the same project.

Append Data Data files from the same site can be appended to create long continuous projects
that are several months or several years long. Make sure to append data only
from the same site.
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The data file will open in the Raw data view. Flo-Ware copies the selected data file(s)
and imports it into the project, leaving the original raw data file unchanged and intact
for archival purposes.

3.2.3.1 Change file properties

In the Open File window, the properties of a data file can be changed. For example, if the
wrong year was assigned to a connected flow meter during installation, the start date for
the file can be changed.

Note: The file properties cannot be changed for project files.

1. Click the FILE OPEN button and select the file type and path in the Open File window.

2. Highlight the file name and click Properties. The File Properties window opens
(Figure 3).
3. Click in one of the fields, edit the information and click OK.

Figure 3 File Properties window
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3.2.3.2 Make a new data file

3.2.3.3 Delete files

The user can make a new data file from one or more highlighted data files. This can be
useful when several data files exist for one month of data, for example. The first data file
may not start exactly on the first day of the month at 0:00 hours, and the last file may not
end exactly on the last day of the month at 24:00 hours. These data files can be combined

into one data file that is exactly one month long.
Note: Some instruments that are supported by Flo-Ware allow the user to select the exact span of
data. In this case, a data file can be created with the exact span that is needed.

1. Click the FILE OPEN button and select the file type and path in the Open File window.

2. Highlight one or more file names and click Create data file. The Select Data Span
window opens.

Note: To open multiple files, highlight the first file, then hold down the Ctrl or Shift key and
highlight additional files.

3. Select or enter the start date and time, the end date and time and click OK. The Save
File window opens.

4. Enter a name for the file and click Save.

Data and project files can be deleted if necessary.
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1. Click the FILE OPEN button and select the file type and path in the Open File window.
2. Highlight the file name to delete and click Delete. A confirmation window opens.
3. Click YES to delete the file.

3.2.3.4 Copy files to a new location

3.3 Themes

A data or project file can be copied and pasted to a different location on the computer or
network.

1. Click the FILE OPEN button and select the file type and path in the Open File window.
2. Click the check box next to one or more file names.

3. Click Copy Checked files to. Select the new location on the computer or network and
click OK. The files are copied and pasted to the new location.

Themes are shown as data columns in the Raw Data view. Each theme name is also shown
in the Themes panel (refer to Figure 1 on page 7).

The available themes correspond to the channels that were selected for logging during the
site setup of the associated instrument. For example, the level and velocity themes are
shown when a Flo-Tote 3 sensor is set up with level and velocity logging. A flow theme is
also calculated and added.

The check boxes in the themes panel allow the user to show or remove a theme in charts
and text reports. Themes are always shown in the raw data view. To change the order of a
theme, click and drag the theme up or down in the Themes panel.

3.3.1 Set up themes

Themes can be shown in a chart with different colors and attributes such as line width or
style. For example, the velocity theme can have one color and the level theme can have a
different color.

1. Right-click a theme name from the Themes panel and select Theme Setup. The
Properties window for the theme opens.

2. Change the attributes that are shown on each of the tabs and click OK.

Option Description

General Changes the basic attributes of a theme such as the name and units. The
available attributes change with the type of chart that is selected in the View
panel.

Marks Changes the appearance of the marks or labels on a chart that shows individual
data points. The changes affect only the theme that is selected on the General
tab.

Line, Bar or Changes the appearance of the theme in a line, bar or area, pie or scatter chart.

Area The available attributes change with the theme that is selected on the General
tab.

3.3.2 Edit site information

The user can view and edit information about the site that is associated with the data file.
This may be necessary after data entry errors are made in the field. Each supported
instrument will have its own site information attributes.

1. Right-click the theme name from the Themes panel.
2. Select Site Information. The Site Information window opens.
3. Edit the site information and click OK.

Note: Refer to the help system for the associated instrument for more details about Site
Information.
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3.3.3 Delete a theme

A theme can be removed from a project at any time.

1.
2,
3.

Right-click the theme name to be removed from the Themes panel.
Select Delete Theme. A confirmation window opens.
Click YES to delete the theme.

3.3.4 Make a custom theme

A Custom Theme adds a new column in the raw data view for user data such as infiltration/
inflow, temperature, pH or maximum allowable flow.

1.

3.4 Charts

Click Custom Theme in the Options view and select New. The Data Interval window
opens.
Enter the start time and end time. If the project is new, select the data interval.

Note: If in an existing project, the interval that was set when the first file was added to the project
is used for the data interval.

Click OK. The Custom Unit Editor window opens.
Define the units of measure for the chart and report labels:

« Standard unit of measurement—enter the units and abbreviation.

« Unit of measurement for totals—enter the units and abbreviation to use for totals.
If the standard unit involves a rate, select the rate of measurement.

Click OK. The Custom Properties window opens.

Enter a name for the custom theme.

Make selections on the General, Marks and Attributes tabs to define all of the

attributes for the new custom theme. Click OK.

To add data, select the Raw Data view. Type the data in the new column or paste data
from a program such as Microsoft Excel spreadsheet software.

All charts and text reports will reflect the selections that were made for the custom
theme.

To view data in a chart, open a data file and click Chart in the View panel.

3.4.1 About charts

Charts allow the user to see the data in a graphical format. Charts can show trends,
anomalies, maximums, minimums and totals. Data can be shown in 4 different types of
charts:

Combination—shows data as a line, a bar or an area. One theme can be shown as a
data line, for example, and another theme can be shown as a bar

Bar—shows data as vertical bars. The summary type for the theme must be set to show
total values. The total values are calculated based on the data interval. Each theme is
shown as a portion of each bar.

Pie—shows data as a area. The summary type for the theme must be set to show total
values. The total values are calculated based on the data interval. Each theme is shown
as a section of the pie. The pie chart should only be used with the same type of data,
for example flow data.

Scatter plot—shows data as (X, y) data pairs for two different themes. The first two
checked themes are shown on the chart. The first checked theme is shown on the x-
axis and the second checked theme is shown on the y-axis. To show the data for
different themes, select or deselect the check box next to the theme name or change
the order of the themes.
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Use the buttons on the chart toolbar to navigate in the chart. To move the chart to the right
or to the left, click on the PAN button, then right-click on the chart and drag the mouse to
the left or right. The ZOOM IN and ZOOM OUT buttons allow the user to increase or
decrease the amount of data that is shown in the chart view. The chart length can be
increased up to 1 year.

Charts can have multiple pages. The page navigator in the main window shows the total
number of pages and the page number that is currently shown. Click the right or left arrows
to go forward or back, or enter a number in the edit box and press ENTER on the computer
keyboard.

3.4.2 Set up charts

The appearance of charts can be configured for attributes such as background color, titles,
legends and 3-dimensional effects. The changes affect all of the themes in a project. After
a chart is configured, the settings can be saved to a template for use with other data files.

Open a data or project file.

Click Chart from the View panel.

Select a chart type (Combination, Bar, Pie or Scatter).

Click the CHART SETUP button from the Chart toolbar. The Chart Setup window opens.
Change the attributes that are shown on each of the tabs and click OK.

aprvbd-=

Option Description
General Changes the data span per chart page and sets 3D effects.

Background Changes the background color of the chart and adds a background image or
frame.

Legend Changes the location and style of the legend.

Axes Changes the settings for any axis of the chart. Select one of the axes from the
left panel and then change the attributes for that axis.

Titles Adds up to 9 different titles in a chart. Select one of the options from the left panel
and then change the title attributes for that option.

Walls Change the appearance the 3-dimensional walls that make up a 3D chart. The
3D Charting option must be enabled in the General tab of the Chart Setup
window. Select one of the walls from the left panel and then change the attributes
for that wall.

3.4.21 Change the data range

The data span for the chart is shown in the Report Settings panel. The data span, chart
length and data interval can be changed and the updates can then be seen in the chart view.
Changes that are made to the span, chart length and data interval will change the number
of chart pages.

Report Setkings

Project Data Span
8/11/2009 11:35 AM
8/27/2009 11:50 AM

‘Custorn Diata Span’

8/11/2009 11:35 &M
B/27/2009 11:50 AM

Chart Length
| 1 Weelk V|

Data Average

|1H|:-ur v|
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1. Select the check box next to Custom Data Span in the Report Settings panel. The start
and end dates are shown.

2. Tochange the date and time range, click on the start time or end time. The Date/Time
window opens. Select a new date and time range and click OK.

3. Select a chart length to be shown on each page of the chart.
4. Select the data interval to be shown. The chart view is updated to show the changes.

3.4.2.2 Make a template for charts
The settings that are made in the Chart Setup window can be saved as a template file for
use with other data files.

1. Click onthe CHART TEMPLATE button on the Chart toolbar. The Template Set Options
window opens.

2. Select Save Template Set and click Next. The Save Template Set Options window
opens.

3. Select one of the options:

»  Save as Default Template—the current chart settings are used automatically each
time a chart is viewed. Click Finish and YES.

» Save Template Set to File—the current chart settings can be saved and loaded into
a project at any time. Click Next. Enter a file name and description for the new
template. Click Finish.

3.4.2.3 Use achart template
A chart template can be used as the default setup for charts, or it can be imported at any
time.

1. Click onthe CHART TEMPLATE button on the Chart toolbar. The Template Set Options
window opens.

2. Select Load Template Set and click Next. The Load Template Set Options window
opens.

3. Select one of the options:
* Load Default Template Set—use the default template to make a new chart. Click
Finish.
* Load Template Set from File—use a previously saved template for the current
project. Click Next. Select a template file from the drop-down box. Click Finish.

3.4.3 Print a chart
A paper copy of a chart can be made from a local or network printer.

1. From the View panel, select Chart.
2. Click the PRINT button. The Print window opens.

3. Select the printer, the number of pages to be printed and make any necessary changes
to the properties. Click OK. The chart is sent to the printer.

3.5 Reports

Reports of raw data can be shown for different time intervals or as a summary of maximum,
minimum, average and total values.

3.5.1 Make a report
Use the Text Report toolbar to make a text report.
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1. Open a data or project file.
2. From the View panel, select Text Reports.
3. Select a report type from the Available Reports drop-down list on the Text Report

toolbar. The report is shown in the view window. Use the page navigator on the main
toolbar to view additional pages.
Note: After a report type is selected, it is available in the Installed Reports list.

4. To add or remove a theme (column), go to the Themes panel and select or deselect a
theme.

5. To change the order of themes, go to the Themes panel and click and drag the theme
name up or down.

6. To change the date range:

a. Go to the Report Settings panel.

b. Selectthe check box nextto Custom Data Span. The start and end dates and times
are shown.

c. Click on the start or the end date and time. The Date/Time window opens.

d. Select a new date and time and click OK. The report will update and show the new
date and time.

3.5.2 Print a report

A paper copy of a report can be made from a local or network printer.

1. Open a text report.
2. Click the PRINT button. The Print window opens.

3. Select the printer, the number of pages to be printed and make any necessary changes
to the properties. Click OK. The report is sent to the printer.

3.6 Data reconstruction

The data reconstruction workspace gives the user the flexibility to analyze data and, if
necessary, repair or reconstruct the data. The example in this section describes the removal
of an error in the velocity theme from a flow meter.

3.6.1 About data reconstruction

When a set of data suddenly shows a large change from a stable pattern, the data should
be examined to find the cause for the change. As an example, imagine that the flow and
velocity themes suddenly become erratic and go to very low values for approximately 1 day.
This change can be due to a true decrease in the flow, or to a condition such as debris that
collected on the sensor.

Upon examination, the level theme shows a stable pattern for this day. If the flow actually
did decrease, the level data is expected to decrease also. The conclusion can then be made
that the velocity data has an error on that day.

This error can be removed with the reconstruct option. The span of inaccurate data can be
replaced with a span of data that is known to be accurate. The result will be more accurate
data, better flow balances and a higher level of statistical confidence.

The line chart or the scatter plot can be used to remove errors from most data files. The line
chart is used to repair sections of data (Use a recontruction table on page 17). The scatter
plot can be used to reconstruct an entire set of data (Use the scatter plot on page 18).
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3.6.2 Use a recontruction table
The example that follows shows the removal of an error in the velocity theme based on the
level data. The level data is referred to as the Base Theme. Before reconstruction, find a
span of data that is considered to be accurate and that follows a noticeable pattern.

1.

10.

1.

12,

13.

Open the data or project file and select View>Chart. Select the Combination Chart from
the toolbar.

Right-click the Velocity theme in the Themes panel and select Reconstruct. The
Reconstruct Velocity window opens.

Select the Level theme from the drop-down box as the basis for the reconstruction and
click OK. The Data Reconstruct panel is shown.

In the Data Reconstruct panel, select Table > New. The Reconstruction Table
Properties window opens.

Note: To edit a reconstruction table that was previously saved from the same site, select Table
> Open.

Update the options as follows:

» Decimal Precision—set the decimal precision for the 2 themes. The higher the
precision for the base theme, the longer it will take to populate the table with data.

+ Base Theme Data Range—select the approximate minimum and maximum values
of good data for the base theme (as seen in the line chart).

* Notes—enter a comment about the site for future use.
Click OK. A data reconstruction table is added to the Data Reconstruct panel.

The left column of the table shows the Base Theme. The right column of the table shows
the theme to be reconstructed.

In the chart, select a span of data that is known to be accurate. First, left-click the start
of the data, then right-click the end of the data span. The selected data for both themes
will change color. Make sure that the selected span includes only accurate data.

Note: If the Pan or Zoom buttons are enabled, the data cannot be selected.
In the Data Reconstruct panel, select Table > Populate with Data. The velocity data will
be added to the velocity column. Some of the data cells will be empty.

Use one of the options that follow to fill in the empty data cells:

+ Select additional data spans to populate the table with more data.
* Enter a reasonable value for the velocity using the keyboard.

* Interpolate over blank cells: click and drag to highlight data from above the first
empty data cell to below the last empty data cell. Select Edit > Interpolate. The table
is updated with the linear interpolated data. The start and end cells are used as
reference points.

+ Change to the Scatter Plot view and click in the scatter plot where the data should
likely be (refer to Use the scatter plot on page 18).

Select a span of inaccurate data in the chart. First, left-click the start of the data, then
right-click the end of the inaccurate data span. The selected data for both themes will
change color. Make sure that the selected span includes the data to be reconstructed.

Note: If the Pan or Zoom buttons are enabled, the data cannot be selected.

In the Data Reconstruct panel, select Table > Reconstruct. The theme is updated to
show the correction (Figure 4).

Select Table > Save to save the table. Enter a file name and location to store the file.
Note: This table can be used for future data reconstruction at the same site.

Close the Data Reconstruct panel to exit the reconstruction session.

Note: To reverse the reconstruction, select the Raw Data view and click the undo button.
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Figure 4 Data before and after reconstruction

1 Valid data

| 2 Incorrect data

3

Repaired data

3.6.3 Use the scatter plot

Use the scatter plot when it is necessary to reconstruct the entire set of data. First, select a
span of accurate data with the line chart to populate the reconstruction table. Then change

to the scatter plot view to reconstruct the data.

1.
2,

Complete step 86 to step 94 to in Use a recontruction table on page 17.

Click on the SCATTER PLOT button. The data from the reconstruction table is shown
in the scatter plot in a different color from the rest of the data set (Figure 5).

If necessary, edit the data in the reconstruction table. The data points on the scatter plot

are updated to show the new values.

In the Data Reconstruct panel, select Table > Reconstruct. The entire set of data is

updated to match the table data (Figure 5).

Save the reconstruction file and close the Data Reconstruct panel.
Note: To reverse the reconstruction, select the Raw Data view and click the UNDO button.

Figure 5 Data before and after reconstruction
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Section 4 Device communication

ACAUTION

Refer to the safety information in the user manual for the device before any connections are made
to the device.

When the driver for a device is installed, Flo-Ware can communicate directly with the device
for various purposes such as data collection and site configuration.

4.1 FL900 series logger
4.1.1 Initial setup

4.1.1.1 Install the FL900 driver
Pre-requisite: Before the FL900 logger is attached to a computer, make sure that Flo-Ware
is installed on the computer.
The FL900 Series Driver must be installed on the PC to communicate with the logger.

1. Find the link for the FL900 Series Driver on the Flo-Ware CD or from the website
http://www.hachflow.com/p_soft_floware_down.html

2. Click on the link and run the application. The install wizard starts.
3. Follow the on-screen instructions to install the driver. Use the recommended settings.

4.1.1.2 Attach the logger to the computer

Pre-requisite: Make sure that the FL900 driver is installed on the computer.
Connect only one logger to the computer.

1. Attach the logger to the computer (Figure 6).

2. When a USB cable is attached for the first time, the Found New Hardware wizard opens.
Run the new hardware wizard to install the USB driver for the logger. When finished,
the message “Your new hardware is installed and ready to use” is shown.

Figure 6 Attach the logger to a computer

19


http://www.hachflow.com/p_soft_floware_down.html

Device communication

4.1.1.3 Attach a sensor to the logger
Pre-requisite: Make sure that the connection status is offline.

The IP67 rating of the sensor connector is applicable only when the cap is installed on unused
connectors.

The number of sensors that can attach to the logger varies with the model of the logger.

1. If the sensor cable has connectors on both ends, attach the cable to the sensor first.
2. Attach the sensor to any SENSOR port on the logger (Figure 7). Tighten the connector
by hand.
Note: For rain gauges, attach the sensor to the RAIN connector.
3. Align the desiccant hub vertically and make sure that the air port points down
(Figure 7).

Figure 7 Attach a sensor to the logger

4.1.2 User interface and navigation

4.1.21 Driver window description
From the Options panel in Flo-Ware, select FL900 Series>Communications. The FL900

Series Driver window opens (Figure 8). The FL900 Series Driver window has tabs and
buttons to complete tasks or access menus. The connection status is shown on the bottom
bar (Connection status on page 21).
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Device communication

Figure 8 FL900 Series Driver window
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41.2.2 Connection status
The connection status shows when a communication session is open:

* Online—a communication session with the logger is open. Any attached sensors are
shown in the driver window. The user can download and view data from the logger and
write a program to the logger.

+  Offline—the FL90O0 driver is not connected to the logger. The user can open a site file
or make a logger program for later use.

41.2.3 Toolbar

The toolbar buttons are always shown, but some buttons are enabled only when the
connection status is online or offline.
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1S

Connect—starts a communication session with the
logger.

“%

Download since last—downloads only the data
that was logged since the previous download.

e

Disconnect—stops the communication session
with the logger.

[

Open a file—opens a site file or sensor
diagnostics file from the default file path.

%

Global settings—opens the settings window where
various default settings such as file paths can be
changed.

Help—opens the help window.

&

Download all data—downloads all data from the logger.

4.1.2.4 Menu tabs

Use the tabs to access the various menu options:

Programming—sets all of the user-adjustable parameters in the logger.

Data—allows the user to view data (tabular and graph) and get sample history from a
site file that has been downloaded from the logger.

Diagnostics—contains the event log, alarm log, current status of the logger and real-
time modem and sensor diagnostics.

Utilities—contains tools such as firmware updates.

4.1.3 Connect to the logger
When a communications session is started, the connection status changes from offline to

{:I online.
l.:> 1. In the FL90O Series Driver window, click the CONNECT button. The Communications
window opens.

Select the computer port (COM or USB) from the drop-down list. For COM ports, select
Note: When a USB cable is attached to the computer, a virtual serial port (e.g. USB:COM3) is

Click OK. The driver reads the logger program and looks for sensors that are specified

* The current logger program includes a sensor that is attached to an incorrect port

2,
the communications protocol for the computer.
assigned.
3.
in the program.
A Sensor Mismatch message is shown for the following situations:
* The current logger program does not include an attached sensor
« The current logger program includes a sensor that is not attached
4,

If the Sensor Mismatch message is shown, select one of the options and click OK:

» Use existing logger program—ignore the attached sensors and import the program
from the logger.

+ Create new logger program based on detected sensors—include the attached
sensors in a new program. The new program can then be written to the logger.
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M Sensor Mismatch

A conflict was identified in the channel configuration
between the logger program and sensors connected to

it!

Select one of the options below to proceed

f+ Lse existing logger program.

(" Create new logger program based on detected sensors,

3

4.1.4 Make a logger program
The logger must have a program to specify all of the necessary parameters for data
collection. The program can be made when the logger is online or offline. When made offline,
the program is saved to a file and later written to the logger.
The logger can have only one program. When a new program is written to the logger, the
previous program is erased.

1.

@

From the Options panel in Flo-Ware, select FL900 Series>Communications to open the

driver window.

Start a communication session.

Click on the Programming tab in the FL900 Series Driver window.

Complete each menu option:

Option

Site information on page 24

Communications settings—
remote on page 24

Communications settings—
local on page 24

Datalog setup on page 25

Flo-Dar setup—Cal Wizard
on page 26

Flo-Dar setup—manual
on page 27

Flo-Tote setup—Cal Wizard
on page 31

Flo-Tote setup—manual
on page 32

Set up alarms on page 32

Set sampler options
on page 34

Description

Specifies general settings such as the model number, site

ID, time zone, memory mode and GPS coordinates.

Contains the remote communication settings for the
logger.

Contains the local communication settings for the logger.

Specifies which measurements will be recorded, what

values trigger an alarm and what actions will occur during

an alarm condition.

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration wizard.

Sets the sensor units, flow channel geometry and the
sensor calibration manually.

Sets the sensor units, flow channel geometry and the
sensor calibration with the calibration wizard.

Sets the sensor units, flow channel geometry and the
sensor calibration manually.

Sets the system alarms and specifies the address or
number for email or text message notification.

Specifies the time interval that triggers the sampler to
collect samples.
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4.1.41

Site information

The site information menu contains the identification information for the site.

1. Click on the Programming tab in the FL900 Series Driver window.
2. Complete the information in the Site Information menu:

Option Description

Model Number If online, the model number is selected automatically. If offline, select the
model number of the logger that will be programmed.

Site Identification Enter a unique name for the site (mandatory, maximum 16 characters).
When telemetry is used for remote monitoring, a site repository is made on
the server with this name.

Site Location The optional location description (maximum 30 characters).

Time Zone Select the correct time zone for the site. When telemetry is used, the server
uses this time zone to synchronize the clock.

Memory Mode The memory mode specifies how the datalog operates when the memory
becomes full. Wrap (default): the oldest data points are deleted as new data
is added. Slate: data collection stops.

Site Notes Click the note icon to enter optional comments. Click the save icon to save
the comments. The note file is saved as a .sn file in the default file path
location.

GPS Coordinates Enter the GPS coordinates for the site (optional). Use Datum WGS84 as
the reference location and the format that is shown for Latitude and
Longitude. When telemetry is used, these coordinates are shown on the
map in FSDATA.

4.1.4.2 Communications settings—local

Local settings apply when the logger is connected to a computer with a communications
cable. These settings are stored in the logger. When a communication session is started,
the settings in the computer must be the same as the settings in the logger. The default
local settings are sufficient for most applications. Change the settings only for specific
communication requirements such as connection to a third-party device.

1. Click on the Programming tab in the FL900 Series Driver window.
2. Click on the Communications menu.
3. Change any of the options:

Option Description

Modbus Address The address that is used for network communication with the logger (default
address: 2).

Baud Rate The baud rate assigned to the logger.

Parity Even, odd or none.

Protocol Modbus RTU (default) or Modbus ASCII.

41.4.3 Communications settings—remote

A modem can be used to transmit data to a server or to send email or text messages from
the logger. The modem can be for wireless or landline (dialup) communication. When a
GPRS wireless modem is used, the user must first install the SIM card from the mobile
provider (refer to the documentation for the logger).

For connection to the internet, the user must first configure the server for the instrument and
get the Security Verification Code (SVC). Refer to the user manual for the FL900 logger for
more information.
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1. Click on the Programming tab in the FL900 Series Driver window.
2. Click on the Communications menu. If online, most of the settings are completed

automatically.

3. Change any of the options for the modem:

Option
Enable Modem

Modem Type

Modem Frequency

Network Provider

Access Point Name

Username

Password

Programming Code

Mobile Station ID

Mobile Data Number

Primary dial number

Secondary dial
number

Description

Makes the modem active. If the modem is not used, deselect this
option to save battery power.

Selects the type of modem (refer to the label on the logger). Options:
GPRS, Verizon, Sprint, Dialup.

GPRS only—sets the modem frequency to be used. Options: 850,
900E, 1800, 1900, 850/1900 (North America), 900E/1800 (EU), 900E/
1900 MHz.

Wireless only—selects the mobile provider. Options: EU Mobistar 1,
EU Mobistar 2, US AT&T Cingular, US TMobile.

GPRS only—the access point name is entered automatically when
the network provider is selected.

If the network provider supplied a user name and password, enter the
information.

f the network provider supplied a user name and password, enter the
information.

Verizon or Sprint only—this information is supplied by the network
provider.

Verizon or Sprint only—this information is supplied by the network
provider.

Verizon or Sprint only—this information is supplied by the network
provider.

Dialup only—this information is supplied by the internet service
provider.

Dialup only—this information is supplied by the internet service
provider.

4. Change any of the options for the server:

Option
Server IP Address
Port Number

Primary Call Interval

Secondary Call Interval

SMS to E-mail Gateway
SMS Service Center
Server Verification
Code

4.1.4.4 Datalog setup

Description
Internet server address, supplied by the manufacturer.
Internet connection information, supplied by the manufacturer.

The frequency that the logger calls the server, not to exceed the
logging interval. Options: 5, 6, 10, 12, 15, 30, 60 minutes; 2, 3, 4, 6,
12, 24 hours.

The frequency that the logger calls the server during an alarm
condition. Options: 5, 6, 10, 12, 15, 30, 60 minutes; 2, 3, 4, 6, 12, 24
hours.

GPRS only—completed automatically when the provider is selected.
GPRS only—completed automatically after the provider is selected.

The customer-specific ID that connects an instrument to the customer
account during telemetry.

Use the datalog setup menu to specify which channels will be recorded in the datalog. A
channel can be a reading from an attached sensor, the battery voltage from the logger or a
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statistical value based on a sensor reading. A channel must be selected before any data

can be saved. A maximum of 16 channels can be selected.

Note: If channels are added to or removed from an existing program, all data in the logger will be
erased. Be sure to download the data from the logger to a safe location before the modified program
is written to the logger.

1. Clickonthe Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports are shown.

2. |If offline, click on the Datalog Setup menu. Select the sensor(s) from the drop-down list
in the Port Assignments section that agree with the sensor and port configurations on
the logger.

3. Click on the Datalog Setup menu.
4. Select the channels to be logged in the Select Datalog Channels section:

a. Expand the tree for the Logger channel group. The Power Supply channel is always
shown in this group. If the logger contains a port for a rain gauge, the Rain channel
is also shown. To include a Logger channel in the datalog, select the check box
next to the channel name.

b. Expand the tree for each Port[1 ](Sensor Name) channel group to view the available
channels for the sensor.

¢. Toinclude a Sensor channel in the datalog, select the check box next to the channel
name. The log channel count increases each time a channel is selected.

Note: For loggers with multiple sensor ports, the port number is added to the channel name.
For example, Velocity 3 is the velocity channel name for sensor port 3.
-I-[JLogger
+- [#] Pawer Supply
+- ] Rain
-I-[JPartl (Flo-Dar)
+- [ Level
+- [ velacity
+- [#] Flow

+- [¢] Temperature

+- [#] Surface Velocity

+- [ Distance

5. To set the logging interval for a channel group:

a. Click on the channel group name, for example Port1 (Flo-Dar). The logging
intervals are shown.

b. Select the interval from the drop-down list. The primary logging interval is used for
normal operation. The secondary logging interval is used during alarm conditions.
Note: The logging interval cannot be set for an individual sensor channel.

6. To change the units for a channel, click on the channel name. The units are shown.
Select the units from the drop-down list.

4.1.4.5 Flo-Dar setup—Cal Wizard

The sensor can be configured and calibrated with the calibration wizard. The sensor must
be installed in the process and must be online for calibration.

1. Click onthe Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports are shown.

2. [f offline, click on the Datalog Setup menu. Select the sensor(s) from the drop-down list
in the Port Assignments section that agree with the sensor and port configurations on
the logger.

3. Click on Sensor Port[1] (sensor name).

4. Select the units in the Unit Preferences section. These units can be different from the
logged units that are specified in the Datalog Setup menu.
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5.
6.

8.

Click on the CAL WIZARD button. The Calibration Wizard window opens.
Select the options on each screen and click NEXT:

Option Description
Number of The number of times the sensor is sampled for the calibration
samples measurements (1, 2 or 3).

Flow parameters = The shape and dimensions of the flow channel (circular, rectangular,
trapezoidal or U-shaped).

Ultrasonic The level (depth) sensor that is used during non-surcharge conditions
transducer (standard or extended range).

Surcharge velocity The SVS sensor for velocity measurements during surcharge conditions
(yes, no. If yes, select the sensor port where the SVS is attached).

Sensor height The distance from the bottom of the flow channel to the top of the sensor
frame (direct—measured by user or indirect—measured by sensor. If
indirect, the user must enter the liquid level after the measurement has
been sampled from the sensor).

Calibration screen The calibration measurements are taken.
Actual level The liquid level (depth) in the flow channel.

Actual velocity The user can measure the velocity with a different instrument and enter
the value (optional).

When the Calibration Complete screen is shown, click FINISH. The Calibration Wizard
window closes.
Note: The Calibration Complete screen shows the values that were entered by the user and the

values that were measured by the sensor. If the values are different, the calibration adjustment
value or multiplier is shown.

Click WRITE TO LOGGER to save the settings.

41.4.6 Flo-Dar setup—manual
The Calibration Wizard is the easiest method to set up the sensor. Use the manual setup
for odd-shaped flow channels or to adjust some of the calibration parameters. The sensor
must be installed and online. Be sure to complete the level calibration before the velocity

calibration.

1. Click onthe Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports are shown.

2. [If offline, click on the Datalog Setup menu. Select the sensor(s) from the drop-down list
in the Port Assignments section that agree with the sensor and port configurations on
the logger.

3. Click on Sensor Port[1] (sensor name).

4. Select the units in the Unit Preferences section. These units can be different from the
logged units that are specified in the Datalog Setup menu.

5. Click on the Flow Settings tab and select the shape of the flow channel.

6. Enter the dimensions of the flow channel.

7. If the flow channel is odd-shaped, a table is shown. A cross-section of the shape can
be divided into parts and the area of the parts can be entered into the table.

8. Click WRITE TO LOGGER to save the settings.

9. If an SVS sensor if used, complete the following steps:

a. Click on the Surcharge Settings tab.
b. Select the Use SVS Sensor check box.
c. Select the sensor port on the logger where the SVS is attached.
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d. Change any of the SVS settings if necessary:

Option Description

Reversed SVS Sensor  Select if the Flo-Dar sensor is installed in the reverse direction.

Conductivity Trigger The conductivity value that starts the Flo-Dar surcharge mode
(secondary trigger).

Distance Turn-On The distance that starts the SVS operation (primary trigger).

Distance Switchover The distance that starts the Flo-Dar surcharge mode (primary
trigger).

Surcharge Level Trigger The surcharge level that starts the SVS operation (secondary
trigger).

SVS Velocity Multiplier The multiplier that is used to adjust the SVS measurements.

Note: After the SVS port number is specified in the Flo-Dar setup, the menus are the same
for the Sensor Port[1] (Flo-Dar) and the Sensor Port[2] (SVS) screens.

If an SVSis not used, make sure that the Use SVS Sensor check box is not selected.

4.1.4.6.1 Calibrate the surcharge level

Calibration of the surcharge level sensor is usually not necessary when the auto calibration
function is enabled. The value for the surcharge level should be zero during normal flow
conditions. If the value is high or drifts, replace the desiccant cartridge.

1.

6.

Click on the Advanced Settings tab in the Sensor Port[1] (FloDar) menu and click
CALIBRATE. The Surcharge Level Calibration window opens (Figure 9).

Click TAKE SAMPLE. The sensor measures the surcharge level. When complete, the
value is shown in the Sensor field.

If the measured depth is not zero (or the measured value), enter zero (or the measured
value) in the Actual field. The offset is calculated and shown. The offset is used to adjust
the measured value to the correct value.

Click OK.

Change any of the surcharge level settings if necessary:

Option Description

Level Calibration = Shows the current value for the level calibration.

Stability Variance Changes the required stability for auto calibration.

Trigger Count Changes the required number of stable readings for auto calibration.
Auto Range Min Negative value limit for auto calibration.

Auto Range Max  Positive value limit for auto calibration.

Click WRITE TO LOGGER to save the settings. The level calibration is complete.

Note: The data in the Quality Parameters section should not be changed unless recommended
by technical support.
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Figure 9 Surcharge level calibration

Surcharge Level Calibration

Sensor: in
actual: 1] in
Offset: 0.3900 in il i
oK Take Sanpe | Cancel
Calibrkakion Success

4.1.4.6.2 Calibrate the ultrasonic level sensor
Calibrations must be done at the location where the sensor is installed. The sensor does
not need to be calibrated again unless it is moved.

1.
2,

No ok

Click on the General Settings tab.

In the FloDar U-Sonic Level Settings section, select the Transducer Type (standard or
extended range).

If the sensor height is known, enter the value in the sensor height field. The sensor
height is the distance from the bottom of the flow channel to the top of the sensor frame.
If the sensor height is not known, do the following:

a. Click ENTER. The U-Sonic Height window opens.
b. Click TAKE SAMPLE. The sensor measures the distance to the liquid surface.

c. Inthe Measured Level field, enter the depth of the liquid in the channel. The sensor
height is then calculated and shown in the Sensor Height field.

U-Sonic Height

Distance To Surface: in
19 in
38,5000 in

Cancel

Click OK. The U-Sonic Height window closes.
If there is sediment in the flow channel, enter the amount in the Sediment field.
Click the CALIBRATE button. The U-Sonic Level Calibration window opens.

Click TAKE SAMPLE. The sensor measures the distance to the liquid surface and uses
the sensor height information to calculate the liquid level. After approximately 45
seconds, the level measurement is shown.

Measured Level;

Sensor Height: il

Take Sample |

Calibrkakion Success
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8. If the measured depth is different, enter the measured value in the Actual field. The
offset is calculated and shown. The offset is used to adjust the measured value to the
correct value.

9. Click OK.
10. Click WRITE TO LOGGER to save the settings. The level calibration is complete.

UU-Sonic Level Calibration

Sensar: in
Actual; ol in
Offset: -1.8700 in Il i

(04 | Take Sample | % Cancel

Calibrkation Success

4.1.4.6.3 Calibrate the velocity
Calibrations must be done at the location where the sensor is installed. The sensor does
not need to be calibrated again unless it is moved. Be sure to complete the level calibration
before the velocity calibration is started.

1. Click on the General Settings tab.
2. Inthe FloDar Velocity Settings section, select a Velocity Method:

* Mean Vel—use for circular flow channels.
* Vel Multiplier—use for non-circular flow channels.

3. If the velocity and flow are known, enter a site multiplier.

a. Click the GENERATE button. The Velocity Multiplier window opens.

b. Click TAKE SAMPLE. After approximately 45 seconds, the measured velocity is
shown.

c. Inthe Actual Velocity field, enter the known velocity. The multiplier value is
calculated and the value is shown in the Multiplier field.

d. Click OK.
e. Repeat steps a—d to make sure the velocity is stable.
4. If the average velocity is not known, a velocity profile should be completed.

a. Click on the Diagnostics tab and then the Current Status menu.

b. Record several real-time velocity readings from the Channel Info section.

c. Calculate the average of the real-time velocity readings.

d. Complete a velocity profile. The Open Channel Profiling Handbook is a good
reference on velocity profiling.

e. After the velocity profile is completed, repeat steps a—c.

f. Compare the average velocity from the real-time readings to the velocity profile.

g. Calculate the multiplier to convert the Flo-Dar velocity to the profiled velocity.

h. Click on the Programming tab and go to the Flo-Dar sensor port menu.

i.

Enter the multiplier in the Site Multiplier field in the General Settings tab.
5. Change any of the velocity settings if necessary:
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Option

Site Multiplier

Min FFT Limit

Max FFT Limit

Min Velocity Cutout

Max Velocity Cutout

Description

Adjusts the Flo-Dar velocity to the profiled or known value.
Narrows the processing window of the velocity measurement.
Narrows the processing window of the velocity measurement.

Forces the velocity to a substitute value when the measurement is
outside of a user-specified range.

Forces the velocity to a substitute value when the measurement is
outside of a user-specified range.

6. Click WRITE TO LOGGER to save the settings. The velocity calibration is complete.

Velocity Multiplier

FloDar Velodty:
Actual velodity:

Multiplier:

Ok |

I
e TR—

Take Sample | Cancel

Calibrtation Success

4.1.4.7 Flo-Tote setup—Cal Wizard

The sensor can be configured and calibrated with the calibration wizard. The sensor must
be installed in the process and must be online for calibration. If the flow channel is odd-
shaped, refer to Flo-Tote setup—manual on page 32.

1. Clickonthe Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports are shown.

2. If offline, click on the

Datalog Setup menu. Select the sensor(s) from the drop-down list

in the Port Assignments section that agree with the sensor and port configurations on

the logger.

3. Click on Sensor Port[1] (FloTote).

4. Select the units in the Unit Preferences section. These units can be different from the
logged units that are specified in the Datalog Setup menu.

5. Click on the CAL WIZARD button. The Calibration Wizard window opens.
6. Select the options on each screen and click NEXT:

Option

Number of samples

Flow parameters

Sensor offset
Sediment value

Actual level

Actual velocity

Description

The number of times the sensor is sampled for the calibration
measurements (1, 2 or 3).

The shape and dimensions of the flow channel (circular, rectangular,
trapezoidal or U-shaped).

The difference between the measured level and the actual level.
The amount of sediment in the flow channel.

The liquid level (depth) in the flow channel. If the sensor height was
measured indirectly, the liquid level must be measured manually.

The user can measure the velocity with a different instrument and enter
the value (optional).

31



Device communication

8.

When the Calibration Complete screen is shown, click FINISH. The Calibration Wizard
window closes.
Note: The Calibration Complete screen shows the values that were entered by the user and the

values that were measured by the sensor. If the values are different, the calibration adjustment
value or multiplier is shown.

Click WRITE TO LOGGER to save the settings.

41.4.8 Flo-Tote setup—manual

The Calibration Wizard is the easiest method to set up the sensor. Use the manual setup
for odd-shaped flow channels or to adjust some of the calibration parameters. The sensor
must be installed and online.

4149 Setup alarms

1.

1.

12,

13.

14.

15.

16.

17

Click on the Programming tab in the FL900 Series Driver window. If online, the attached
sensors and ports are shown.

If offline, click on the Datalog Setup menu. Select the sensor(s) from the drop-down list
in the Port Assignments section that agree with the sensor and port configurations on
the logger.

Click on Sensor Port[1] (FloTote).

Select the units in the Unit Preferences section. These units can be different from the
logged units that are specified in the Datalog Setup menu.

Click on the Flow Settings tab and select the shape of the flow channel.
Enter the dimensions of the flow channel.

If the flow channel is odd-shaped, a table is shown. A cross-section of the shape can
be divided into parts and the area of the parts can be entered into the table.
Click WRITE TO LOGGER to save the settings.
Click on the General Settings tab.
. In the velocity settings section, click the CALCULATE button. The Site Coefficient
window opens.
Click TAKE SAMPLE. The velocity measurement starts. When complete, the measured
velocity is shown.

Measure the velocity with a different instrument and enter the value in the Actual Velocity
field. The multiplier value adjusts the sensor reading to be the same as the actual
velocity value.

Click OK.

In the level settings section, click the CALIBRATE button. The Level Calibration window
opens.

Click TAKE SAMPLE. The level measurement starts. When complete, the measured
level is shown.

Measure the liquid level manually and enter the value in the Actual Level field. The offset
value adjusts the sensor reading to be the same as the actual value.

. Click WRITE TO LOGGER to save the settings.

Use the Alarms menu to set up channel alarms, system alarms and notifications. Channels
must first be selected in the Datalog Setup menu before channel alarms can be set. A
maximum of 16 channel alarms can be set.

1.
2,
3.

Click on the Programming tab in the FL900 Series Driver window.
Click on the Alarms menu.
To set a channel alarm, click on the Channel Alarms tab:

a. Click on the ADD ALARM button.The Add Channel Alarm window opens.
b. Select the channel from the drop-down list.
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Select the type of alarm (low/low, low, high, high/high) and click OK. The channel
alarm is shown in the main section.

Enter the trigger value and deadband. An alarm starts when the channel value is
equal to the trigger value. An alarm stops when the channel value goes above (low
alarm) or below (high alarm) the deadband value.

Figure 10 Low alarm example

76071

740

7207

(1) 700

AN o

6.80
6.60 T
6.40 } }
1 Channel value 3 Low alarm stops 5 Trigger value
2 Low alarm starts 4 Deadband 6 Time
e. Select the actions that will start during an alarm condition:

Option Description

Send SMS from logger  Send an SMS (text) message from the logger—useful when
the server cannot be contacted.

Send Email from logger Send an email message from the logger—useful when the
server cannot be contacted.

Trigger sampler When a sampler is attached, start a sampling program.

Switch to secondary log Switch to secondary log interval—the secondary log interval
interval is used.

Switch to secondary call Switch to secondary call interval—the secondary call interval
interval is used.

Send SMS from server Send an SMS (text) message from the server—saves battery
power on the logger.

Send Email from server  Send an email message from the server—saves battery
power on the logger.

4. To set a system alarm, click on the System Alarms tab:

a.

Select the system alarm type:

Option Description

Low Main Power The batteries in the logger or external power supply is less than 8 V.
Low RTC Battery The battery for the internal clock in the logger is weak.

Low Slate Memory The datalog is 80% full.

Slate Memory Full The datalog is full and data collection has stopped.
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Option Description
Sensor Timeout The sensor has not responded to a call by the server.
Sensor ID Error The program cannot detect what type of sensor is connected.

b. Select the system alarm actions:

Option Description

Send SMS from logger Send a text message from the logger via the network provider.
Send Email from logger Send an email from the logger via the network provider.

Send SMS from server Send a text message from the FSDATA server.

Send Email from server Send an email from the FSDATA server.

5. To set enter recipient information for alarm notifications, click on the Recipients tab:

a. Enter the email address for each email recipient (maximum of 5).
b. Enter the number for each SMS (text message) recipient (maximum of 5).

4.1.4.10 Set sampler options
If a sampler is used, the sampler must be attached to the auxiliary port on the logger. Use
the Sampler menu to specify when samples are taken.

Click on the Programming tab in the FL900 Series Driver window.
Click on the Sampler menu.
In the Pacing Source field, select the sensor port that will measure flow for the sampler.

Enter the volume interval that generates a flow pulse to the sampler. For example, a
sampler can take a sample every 100 gallons of flow.

Note: The sampler can also take a sample during alarm conditions if the Trigger sampler action
is set for a channel alarm.

Ao N-=

4.1.5 View data

4.1.51 Download data
When data is downloaded from the logger, the data includes the channel data, the event
log, the alarm log and the sample history. The data is automatically saved as a .fl9 file in
the default file path.

1. Open a communication session with the logger (Connect to the logger on page 22).
2. Click on one of the download options:

Option Description

@ Download all of the data from the logger.

Iﬁ Download only the data that was logged since the last download.

b

3. Wait for the data to download. When complete, a confirmation message is shown. Click
OK. The data is shown in the FL900 window ( Tabular view on page 35).

4.1.5.2 Open a site file
Data files that were downloaded previously can be opened when the connection status is
offline.

1. Make sure the connection status is offline. If online, click on the DISCONNECT button.
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2. Click on the OPEN A SITE FILE button. The Open file window opens.
3. Find the file and click OPEN. The data is shown in the FL900 window ( Tabular view

on page 35).

4.1.5.3 Tabular view

The tabular view shows the data in a spreadsheet format (Figure 11). The following options

are available:
Option

Open in Flo-Ware
Sort data

Show or remove
channels

Change the date
range

Copy to the clipboard

Print

Export as tab-
separated

Export as comma-
separated

Open in Excel

Description
Click on the Flo-Ware icon to open the file in the main Flo-Ware application
Click on a column header to sort the data by that column

Click on the check box next to a channel and click the UPDATE
TABLE button to show or remove channels.

Change the date and time range and click the UPDATE TABLE button.

Click on the copy icon to copy the data to the clipboard. The data can then
be pasted in a spreadsheet or other application.

Click on the printer icon to send the data to a printer.

Click on the TSV icon to export the data as a tab-separated file.
Click on the CSV icon to export the data as a comma-separated file.

Click on the Excel icon to open the data in Microsoft” Excel® spreadsheet
software.
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Figure 11 FL900 tabular data view
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4.1.5.4 Graph view

The graph view shows the data in a line graph (Figure 12). A maximum of 2 channels can
be shown. The rain gauge and sampler are shown as bars in addition to the 2 selected
channels. The bars for the sampler are shown in a green color when a sample was collected
and in a red color if the sampler failed to collect a sample.

The following options are available:

Option Description

Show or remove Click on the check box next to a channel and click the UPDATE
channels TABLE button to show or remove channels.

Change the date Change the date and time range and click the UPDATE TABLE button.
range

Copy to the clipboard Click on the copy icon to copy the data to the clipboard. The data can then
be pasted in a spreadsheet or other application.

Print Click on the printer icon to send the data to a printer.
Export as image Click on the BMP icon to save the graph in a .bmp image format.
Zoom in Click on the graph and drag to the right to zoom in.
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Option Description
Zoom out Click on the graph and drag to the left to zoom out.

Pan left, right, up or  Right-click on the graph and drag to the left, right, up or down to move the
down graph position.

Figure 12 FL900 graph view
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4.1.5.5 Sample log

When a sampler is attached to the logger, the following sample data is collected and shown
in the tabular format:

+ Date and time of the sample

» Sample status (success or failed)
*  Sample number

»  Sample bottle number

Refer to the Tabular view on page 35 for a description of the available user options.

4.1.6 Troubleshooting

4.1.6.1 View diagnostic information
The user can view diagnostic information to help solve a problem or to confirm normal

operation.
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1.

Click on the Diagnostics tab.
2. Select one of the menu options:

Option
Event Log

Current

Status

Sensors

Modem

Alarm Log

Description

The date and time, event number, event text and event data is shown for all events
in the tabular format. Refer to the Tabular view on page 35 for a description of
the available user options.

When online, real-time general information such as the power supply voltage is
shown. The measured channel values are shown and are updated at the same
interval that is set in the logger program. If a sampler is connected, the volume
before the next sample is taken is shown.

When online, the user can download a sensor diagnostic file (.sdf) for use by
technical support. The file is saved in the location that is specified in the settings.
Technical support may ask the user to take a sample or to run diagnostics for a
specified time (1 hour, 1 day or 1 week) to get additional diagnostic information.

When online, information about the modem and the signal strength is shown. The
registration status should show home. The CALL SERVER button can be used to
connect to the server and to show connection information. When the call is
complete, click the SAVE button to save the information.

The data for all alarms is shown in the tabular format. Refer to the Tabular view
on page 35 for a description of the available user options.

4.1.6.2 Manual USB driver installation
If there was a problem with the USB driver installation, install the USB driver manually.

1.
2,
3.

With the logger attached to the PC, open the Windows Device Manager.
Find the FL-9XX port under the Ports node and open the port properties.

Install the driver from C:\Program Files\Flo-Ware\FL9xx\Backup (file name:
FL-9XX_USB.inf).

4.1.7 Update the firmware
The firmware is updated regularly for continued improvement. Install the updates for best

Click on the Utilities tab and select the Firmware Update menu.
Select the file to install.

results.

1.

2.

3. Click START.
4.

Select the udpate option and click OK. The update starts. Wait for the status to show

complete.
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